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The report provides tools to assess human exposure to chemicals emitted by consumer
products. It presents a modelling approach based on mathematical contact, exposure and
uptake models. For each route of exposure, a number of exposure and uptake models are
included. A general framework joins the particular exposure and uptake models. The models
are implemented in a computer program, CONSEXPO.

OUTDATED



page 4 of 64 RIVM report 612810 011

��
��
��

���������

����
���� 
!�"

#
 $
������� �
�%

&
 '(����� ����)����*����#�

	
 $
������� �
�#&

3.1. System requirements 12

3.2. Installation 12

+
 '(�����!����#	

4.1. Introduction 13

4.2. CONSEXPO basics: displays 13

4.3. CONSEXPO basics: setting up an exposure assessment 13

4.4. CONSEXPO basics: reporting exposure and uptake results 14

4.5. CONSEXPO basics: standard setting 17

4.6. Graphical user interface: menu and toolbar 17

,
 ����������
����������������&#

5.1. Introduction 21

5.2. Contact 21

5.3. Inhalation Route 22

5.4. Dermal route 35

5.5. Oral route 42

�
 -��������+"

6.1. Introduction 47

6.2. Disabled database 48

"
 ����(��� ��������������+.

7.1. Introduction 49

OUTDATED



RIVM report 612810 011 page 5 of 64

7.2. Worst case calculations 49

7.3. Distributions 51

7.4. Displaying exposure or uptake distributions 53

7.5. Sensitivity analysis 53

%
 '���� ���,,

8.1. Step 2. 55

8.2. Step 3. 55

8.3. Step 4. 56

8.4. Step 5. 57

8.5. Step 6. 57

/�)���
����,%

����
� ��#�0� � 
!�� ����#

����
� ��&
�-�)������������)�������������&��	

OUTDATED



page 6 of 64 RIVM report 612810 011

�������

The predictive models, the program and the manual presented in this report are tools to assess
human exposure to chemicals emitted by consumer products. Consumer products comprise a
large diversity, ranging from shoe polish, to detergents, to pesticides. All these products may
contain hazardous chemicals, for example active ingredients and contaminants. Human
exposure assessments for these products do not equal measuring product concentrations.
Products will emit their chemicals during use and the concentration in air, water or a diluted
product determines the exposure. The duration of use and residence times in a room or house
determine the duration of exposure.
The present report provides a modelling approach based on mathematical contact, exposure
and uptake models. For each route of exposure, a number of exposure and uptake models are
included. A general framework joins the particular exposure and uptake models selected by
the user. By combining different models and different routes, the program copes with
consumer product diversity. The program allows for stochastic parameters, to include
variability and uncertainty. The program calculates the resulting exposure and uptake
distributions, and allows any percentile to be calculated.
This program is linked to a database, which will contain predefined exposure and uptake
models for categories of product, for example paints or pest control products. The exposure
assessment of a product is initiated with the default models and model parameters according
to their category of products. These can be adjusted to include existing knowledge in the
assessment.
The program reports local exposure concentrations and systemic doses on the acute and
semichronic time scale. These include the mean event concentration, the yearly averaged
concentration, the fraction taken up, the amount taken up during a year (per route and
summed) and the uptake per kilogram body weight per day.
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De voorspellende modellen, het programma en de achtergronden in het rapport zijn bedoeld
voor de menselijke blootstellingschatting van chemische stoffen in consumentenproducten.
Consumentenproducten omvatten een grote diversiteit aan producten, zoals
schoenpoetsmiddel, detergenten en pesticiden. Al deze producten bevatten mogelijkerwijs
voor de mens gevaarlijke stoffen, zoals actieve ingrediënten en verontreinigingen. Een
blootstellingschatting voor dergelijke producten omvat meer dan het meten van
productconcentraties. Stoffen uit de producten komen in lucht of in water en producten
worden mogelijk verdund. Ook de duur van contact en de verblijftijd in huis bepalen de
blootstelling.
Het onderliggende rapport bevat een modelmatige benadering, gebaseerd op contact-,
blootstelling- en opnamemodellen. Voor elke blootstellingroute zijn mathematische modellen
aanwezig. Een algemeen raamwerk verbindt de modellen zoals ze door een gebruiker
geselecteerd zijn. Door verschillende modellen te combineren wordt de blootstelling aan een
product beschreven. In het programma kunnen ook stochastisch parameters gegeven worden,
die verdelingen van blootstelling en opname opleveren. Hieruit kan een willekeurig percentiel
opgevraagd worden.
Het programma is verbonden met een database, waarin voorgedefinieerde blootstelling- en
opnamescenario’s komen te staan. De beoordeling van een product begint dan met de
standaardmodellen en standaardparameters voor de productcategorie. Deze kunnen worden
aangepast om de huidige stand van zaken in de beoordeling te betrekken.
Het programma rapporteert diverse blootstellingmaten, waaronder de gemiddelde blootstelling
gedurende contact, de jaargemiddelde blootstelling, de opname en de opname per kilogram
lichaamsgewicht.
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The CONSumer EXPOsure models (CONSEXPO) application is a computer modelling tool
to assist in residential human exposure assessment. The third version of the application
extends the second substantially and it is described in this report. Four driving forces acted
during update. First the use of CONSEXPO for biocide risk assessment required additional
models e.g. for spraying and for dermal contact. Second, the implementation of a defaults
database and the availability of the first factsheets to fill the database required a version that
could read and use that database. Third, the introduction of 32bits operating systems requested
a 32bit version. Finally, work for the European Institute of Standards (CEN) required
backcalculation: what is the maximum value of a parameter, e.g. concentration of an
ingredient, that causes dose to be just at the toxicologically derived exposure limit.

What is the rationale behind the exposure models in CONSEXPO ? Consumers daily use
products for their personal convenience. Part of these products is food, but another part is used
for all kinds of purposes. Exposure to the latter category of products is characterised by a large
diversity in chemical composition and usage of products. The questions encountered during
the process of human risk assessment are manifold. How to estimate exposure ? Which
exposure data are available ? Are they representative for the situation in which the product is
used ? Which factors that control exposure are important ? Which dose measure to calculate ?
How to treat multiroute exposure ? How to characterise risk ? Which effects cause the main
risks ? On which time scale are effects relevant ? For products used in residential settings
(biocides, plant protection products, toys, textiles, and other kinds of consumer products) risk
assessment follows the same general outline. CONSEXPO is set up to facilitate model
exposure estimates for this process.

The models included in CONSEXPO range from screening models to models predicting
actual exposure. The screening models provide a quick and dirty examination of exposure,
while the actual exposure models aim to predict the time course of exposure. All models,
screening and actual exposure, depend heavily on the applicability of the model assumptions
and the accuracy of the model parameters. Even if assumptions apply, models stay simplified
representations of reality and can not be expected to mimic reality in all aspects and every
occasion.
The program is being developed in the framework of the RIVM project ‘Risk assessment for
consumers’ to improve risk assessment for consumer products. It contains the algorithms
proposed by Vermeire et al. (1993), which are included in the Technical Guidance Document
of the European Union for the risk assessment of existing chemicals (EU, 1996) and the
European Union System for the Evaluation of Substances EUSES (ECB, 1996). The general
context of the CONSEXPO program within the RIVM is sketched by Vermeire and Van Veen
(1996). They also describe other exposure models of the RIVM, covering direct exposure and
exposure through the environment and food chain.
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This software is provided "as is" without express or implied warranty. No liability is accepted
by the developer and his employers, even if errors result from programming or modeling
mistakes.
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Send your comments, questions and bug reports to the author.
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Exposure, defined here as contact with a concentration of a chemical, is determined by issues
as use of products, choice of food items and site of contact. Role of exposure assessment
within risk assessment is to estimate human exposures (in terms of concentrations) and doses
(in terms of mg/day or mg/kg/day) from available data. It starts with specifying emission of
the chemicals and transport to other parts of the residential environment. Emission and
transport determine the concentration time profiles of the chemicals, during and after use of
the product. Humans will contact the chemicals in various ways. For example, a volatile
ingredient will enter air (emission into air and transport within a house), which is inhaled
(human contact). Or the product itself is spilled on the fingers causing dermal contact. By
hand-mouth contact some of the chemical can be transferred to the mouth resulting in oral
contact. Oral exposure can also result from mouthing an object. Uptake into the body will
occur after contact with the chemical and the amount taken up forms the internal systemic
dose.

Residential exposures spring from a large diversity of products. These products contain many
ingredients and an (active) ingredient will be contained in multiple products. In addition,
people show widely differing behaviour in selecting and using products for tasks in the
household (Weegels, 1997). The implications are manifold. If we take a single chemical as
start, it means that assessing a single product may not be sufficient to cover human exposure
as a whole because the chemical might be present in other products as well. In addition,
exposure may also occur at the workplace, via dietary intake and via environmental
contamination. What is needed is an exposure aggregated over the different sources. Much of
the effort to achieve aggregated exposures is concentrated in the United States because the
Food Quality Protection Act recognises that multiple sources may cause exposure to a
chemical.
If we take a single product as start, it means that a product might be used in many ways. A
product like dish washing fluid is not solely used for washing dishes, but acts more or less as a
general purpose cleaner in the kitchen (Weegels, 1997; Weerdesteijn et al., 1999). The
question is which uses fall within the normal range, even when not intended at first, and
which can be set aside as aberrant.
If we take a single task as start, it means that there is a series of products that might be used
for that task. There is some indication of the kinds of product that might be used, but surprises
frequently arise. You would not expect someone to use hair spray for plant care. However,
Weegels (1997) observed a person spraying plants with hair spray to obtain glossy leaves.
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To mathematically estimate the exposure to chemicals emitted by consumer products, Van
Veen (1996) developed a general model framework to include contact, exposure and uptake.
In this framework, exposure is defined as the concentration of a chemical compound in the
medium touching the body. For example, the exposure to an airborne pollutant is expressed in
terms of mg/m3, a concentration measure. Uptake includes both the intake rate of the medium
and the uptake rate of the compound by the body.
To summarise the general model framework, ������� and�������������� represent, respectively,
the potential exposure and uptake, which are converted to their actual counterparts by
specifying �S��� for the path of a person and ���� for the period of contact. The cumulative
amount �F taken up in the body is

U P t U E x t t t dtc p=
∞� ( ) ( ( ( ), ), )

0

where �F is the cumulative uptake (mg), ���� is the contact function, �S��� is the path of a
person, ���S������� is the exposure (mg/cm3) as a function of time and path of a person, and
�����S����������� is the uptake rate (mg/min) as a function of exposure and time. For the
inhalation and the oral routes, the uptake rate �����S����������� can often be written as medium
intake rate �P times absorbed fraction � times exposure �:

U E x t t t I t FE x t tp m p( ( ( ), ), ) ( ) ( ( ), )=

In the CONSEXPO program the spatial dependence of exposure is not included at the
moment. This simplifies potential exposure to a function of time: �����

The CONSEXPO is specifically developed to implement the general consumer product
exposure and uptake model in a user friendly software package. It allows the user to specify
contact, exposure, and uptake by selecting the appropriate scenarios and models from
predefined lists. Then, it integrates contact, exposure, and uptake to calculate time courses of
exposure and uptake.
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The following system requirements apply:
• Intel based PC or a compatible equivalent;
• 32bits MS-Windows operating system (95, 98, millennium, 2000, or NT) installed and

working;
• 5 megabyte of hard disk capacity.
The requirement that MS-Windows 95, 98, millennium, 2000, or NT is installed and working
implies that your machine has an intel-pentium or equivalent processor and that you have at
least 16 Mb of internal memory.
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The installation procedure installs the CONSEXPO software and the defaults database. The
defaults database is under development. At the moment it contains default data for painting
and defaults on the indoor environment, but in the future products and product categories will
be added. Updates of the database will be made available electronically.
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The purpose of the program is to aid in human exposure assessment, focused on non-
professional indoor use of  consumer products. It provides two tools, mathematical exposure
models and a defaults database. The mathematical models form the core of the program as
they provide the dose estimates. The defaults database is set up to provide input to the models.
It presents product categories to the user and after selection of a product category, the database
provides default parameter values to the models. The database enables you, the user, to select
a product instead of a model.
The mathematical models all have their constraints because they are simplified representations
of a part of the real world. The model descriptions in chapter 5 and the on-line help system
both outline these constraints, thereby defining the area of use for a certain model.

+
&
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The program uses two displays to show its information, one for model overview and one for
plotting graphs. The model overview is present at start up. To toggle between the two
displays, use the last two entries in the Options menu or use the rightmost buttons in the
button bar. If exposure can be calculated, the graph display will automatically show the time
course of exposure.

4.2.1. The model overview

The model overview summarises all models that have been set and shows whether sufficient
parameters have been defined. The overview offers a short cut to model definition dialogs by
clicking on the model name (or “none”).

4.2.2. The graphic display

The graph display displays distributions and time courses of exposure and uptake. Selecting
the graph display enables those menu items that plot to the graph display in the Report menu.
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First, define the subject of the exposure assessment in terms of the product, the chemical and
the foreseen use of the product 	�������. Then, start up CONSEXPO for support with the
assessment. An exposure assessment is set up from the “model overview”, where chemical,
contact, exposure and uptake can be defined. The short route of exposure assessment uses the
defaults database. Select the “select product type” button and use the database dialog to find
an appropriate product category (chapter 6 for details). Then select the chemical of interest (or
supply chemical characteristics) and define the chemical concentrations in the exposure
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models. The latter is done by clicking on the model name and selecting “parameters” from the
dialog that follows. If all models have “par. known” below, the input is complete.
A more complicated route follows when none of the product categories applies (which may
often be the case). The exposure models have to be defined directly, which assumes
knowledge about the gist of the various models. Information on the models can be attained
from chapter 5 and the on-line help system. Define the exposure models by selecting the
buttons for contact, exposure and uptake. For all buttons, a dialog will pop up from which
models can be selected, either under ‘scenarios’ or under ‘options’. Select an appropriate
model and select parameters. In the parameter-dialog, provide the parameter values. If all
models signal “par. known” in the model overview, input is complete.

+
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Exposure and uptake results are displayed using the entries of the report menu. The
subentries allow for a numerical (Point) or graphical (Distribution; Time course)
representation of exposure and uptake. Graphical output is only available when the graphical
display is in use, see section 4.2.

���������������	��������
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4.4.1. Point estimates

If the entry Point is chosen, the results are given as a point estimate.  The results are given in
the form of a dialog, in which the values for the estimated exposure and uptake are shown
(fig. 1). Reported are:
1. mean exposure concentration during the event;
2. route specific uptake;
3. cumulative uptake;
4. internal dose on a chronic time scale (year-averaged);
5. internal dose on an acute time scale (on day of exposure).
Depending on the choice made in the Exposure definition dialogs (which can be a choice for
worst case or for average case calculations), this point estimate reflects the average or the
worst case exposure. Which point estimate is shown is indicated to the right of the value,
where WC=worst case and AC=average case. Initially, this sign reads NS=not set. Of course,
if ALL parameters are point  estimates, the worst case exposure is identical to the average case
exposure. If multiple parameters have variation, the worst case estimation is cumulative worst
case.  Each parameter achieves its 95 percentile value and those values are used to calculate
the worst case exposure and uptake results.
The results in the uptake part are always based on the point estimates given in the exposure
part.  Depending on the uptake model, the amount taken up is based on a fraction model (sign
right of value reads F), a flow model (sign reads P, available only for the inhalation route) or a
diffusion model (sign reads D). This choice is set in the uptake definition dialog boxes, which
differ per route. The lower entries give summary measures. On the left, the year averaged
exposure is displayed. On the right, the integrated uptake is displayed, which is uptake
summed over all routes. The upper entry states uptake in mg/year. If the frequency of contact
is once per year, this boils down to the uptake per event. The lower entry states uptake in
mg/kg body weight/day on a semichronic and an acute time scale, the toxicologists views of
uptake. A year has 365.25 days, correcting for leap years. In addition to the amount taken up,
the absorbed fraction through the inhalation, dermal and oral route can be inspected by
choosing the "Uptake Fractions" button.
To inspect the exposure scenarios, uptake models, and their parameter values in more detail,
the Details button is used. After selecting this button, details on the exposure and uptake
estimates are displayed. These details consist of the contact scenario, the exposure scenario,
the uptake model and the parameters used by the models. The worst case estimates given here
reflect the cumulative worst case, not the Monte Carlo worst case estimates. The text viewer
allows its contents to be saved or printed. Quit the text viewer by choosing Exit from the file
menu. The text viewer runs concurrent with CONSEXPO, so you can display the results of
several scenario/model combinations in a number of text viewer sessions. The text viewer is
the Notepad by default, but another text viewer can be set in the System entry of the
Options menu. If you select a different text viewer, then the precise use may deviate from
the description in the above.
To circumvent the cumulative worst case estimates, the Monte Carlo Percentiles part in the
dialog is used to calculate arbitrary percentiles from the eventual exposure and uptake
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distributions. It uses Monte Carlo sampling from the parameter distributions to achieve the
exposure and uptake distributions and rounds the requested percentile to the nearest percentile
available from the Monte Carlo sampling. The number of Monte Carlo samples is set in the
System menu, using the Options entry.  The accuracy of the percentiles is increased by
increasing the number of Monte Carlo samples. Background information on this procedure
and the method that is used for its calculation can be found in chapter 7.

4.4.2. Distribution

An exposure or uptake distribution can be displayed if one or more parameters exhibit
stochastic variation. If all parameters are point estimates, if there are parameters with out of
range values or if there are parameters with missing values, no graph will be shown.
The dialog to select a distribution is divided into an exposure and an uptake part, containing
the distributions that will be shown. Only a single distribution can be displayed, so only one
can be chosen from the list. After pressing the Ok button or pressing the enter key, the
distribution is drawn on the screen. If, during the generation of the distribution, only one
parameter appears to have variation, a point graph is composed, using direct calculations. If
there are multiple parameters with variation, a Monte Carlo method is used.  A histogram
displays the results of Monte Carlo calculations. More information about the use and
interpretation of these distributions is given in Chapter 7.
If the exposure or uptake model is changed after the graph is drawn, the results are not
automatically updated on screen.  The report->distribution entry has to be chosen
again to reflect the model changes in the graph. This way, you are allowed time to observe
changes in exposure or uptake resulting from the model change. The number of bars in the
histogram, the number of points in the graph and the number of Monte Carlo loops can be
changed in the Options entry in the System menu.

4.4.3. Time course

The Report->Time course entry displays the exposure or uptake as a function of time.
The menu entry is only enabled if the graph display is set. To set it, select Options->Graph
Display or press the white button with the graph in the button bar. After choosing the Time
course entry, a dialog box will appear, from which the route of exposure or uptake to be
displayed can be selected. Of course, only exposures or uptakes which have been fully defined
can be displayed. Investigating the time course of exposure or uptake is particularly useful for
non-linear exposure scenarios, such as the inhalation open can scenario that shows a
saturating exposure concentration during long exposures. The plot will be displayed after
choosing the Ok button. To print the plot, choose File->Print Graph while the plot is on
screen.

OUTDATED



RIVM report 612810 011 page 17 of 64

+
,
� ������������ ��2����
��������� 
!

Standard setting concerns the determination of that value of an exposure factor (e.g. leach
rate, concentration in product or emission rate) that just results in the (toxicological) exposure
limit. It can be regarded as ‘backcalculation’. Where in exposure assessment the exposure or
dose is predicted from the underlying exposure factors (the parameters in the model), standard
setting calculates the value of a selected exposure factor from the exposure limit and the other
exposure factors. It is used for preventive risk assessments to determine, for example, the
upper limit of the leach rate such that health risk limits are not exceeded.
CONSEXPO provides provisional standard setting in the standard setting dialog, under
Report->Standard. The calculation for a standard is started by defining an exposure
estimation like you normally would do. Provide all parameters, including the one for which
the standard will be calculated because the standard calculation procedure only works when
the models are able to calculate exposure (check if you can make a graph for the desired
route). Then open the Report->Standard dialog.
The first line of the dialog sets the exposure limit in terms of value and type. The value of the
exposure limit may be derived from toxicological concerns. The type of limit is chronic dose
(mg/kg bw/day), acute dose (mg/kg bw on day of exposure), and air concentration (mg/m3).
The latter is useles for the dermal and oral routes.
The second line defines the route of exposure and the parameter for which the standard must
be calculated. Select the route first, as it will change the contents of the parameter combobox.
The parameter combobox contains those parameters that have a value for the selected route. If
the target parameter is not in the list, it has not been given a value. Return to the model
overview screen and enter all necessary values first. If the items on first and second line are all
defined, the standard calculation is started by clicking on Ok. The third line shows an
indicator for the progress. If the status bar is completely filled the parameter standard value
has been determinated.
After the calculations, the last line presents the standard value of the parameter selected in line
2, or presents an error indicating that a standard value can not be calculated. Reasons for
failure are exposure always below limit, exposure always above limit or calculation failure. In
the first two cases, no value of the parameter will cause exposure to be at the desired exposure
limit. A practical way to proceed is to perform sensitivity analysis for the parameter. In the
latter case, the problem takes to many steps to be solved.
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The menu and toolbar bar is displayed at the top of the CONSEXPO window (fig. 2). The
menu contains entries for handling files and printing (File), system wide settings (Options),
getting help (Help) and defining and analysing exposure and uptake models (Report,
Contact, Exposure, Uptake and Product). The toolbar contains shortcuts to a
number of menu entries. Menu entries and toolbar buttons are explained in the lower bar of
the program when the mouse is on top of an entry or button. Summarised, the menu bar
contains eight main entries.
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• File all commands concerning file handling and graphics printing, and the info and
exit commands,
• Options all commands concerning the calculation routines as a whole,
• Product all commands concerning the retrieval of information from the defaults
database, including product category defaults and chemical properties
• Report  all commands concerning the model results and the definition of models,
Contact  all commands concerning contact,
• Exposure  all commands concerning exposure. It contains the routes contact, and for
each route the appropriate exposure scenario can be selected,
• Uptake  all commands concerning uptake.  It contains the routes of contact, and for
each route the appropriate uptake model can be selected,
• Help  commands to display help information.

4.6.1. File menu

The File menu consists of the following entries:
• New  resets all parameter values and options in order to start a new risk assessment session;
• Open  opens a previously saved risk assessment session;
• Save saves the present risk assessment session. If the session has not been named yet, a

file name is requested;
• Save As name the risk assessment session and save it;
• Print preview preview the graph currently displayed on screen as it will be printed;
• Print print the graph currently displayed on screen. It will be printed on the Windows

standard printer.
• Print set-up set the printer and change the settings of the printer.
• Exit leave the program. All results will be lost unless saved.

4.6.2. Options menu

The System menu is used to set some general model settings:
• System. Displays a dialog box to set system wide properties, including the number of bars

of a histogram, the number of points that are calculated to compose a point graph, the
number of Monte Carlo loops and database properties.

�������"��#���������		��$���	��%&'(�)�&���		��$���$���	����������������� ���
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• Calculator. Shows a calculator which can be used to do additional calculations. The
default calculator is the MS-Windows calculator, but it can be replaced by any other
calculator in the Options entry.

• Graph display. Switch to the graph display screen. The options distribution and
time course in the Report menu become available.

• Model overview. Switch to the model overview screen.

4.6.3. Product menu

The product menu contains entries to read the database.
• Select product type. Select the product type from the defaults database and read

default models and parameter values.
• Select chemical. Select or set the physico-chemical properties of the chemical

compound. If a database is available (see chapter 6), physio-chemical properties can be
loaded by using the select or the retrieve buttons. The select button enables searches with
wildcards (% for matching any length sequence of characters), retrieve performs an exact
search for a name or CAS-number.

4.6.4. Report menu

The Report menu entry is used to view the results of the exposure and uptake model. The
Distribution and Time course entries that use graphical output are only enabled when
the graph display is selected, see section 3.1. Otherwise, these entries are greyed out.
• Point estimates. Show point estimates of exposure and uptake.
• Standards. Performs a standard setting procedure, by backcalculating that parameter

value that just results in a given limit value for chronic or acute dose, or a air concentration.
• Distribution. Show the variability of exposure or uptake in case one or more

parameters are variable.
• Sensitivity. Performs sensitivity analysis of a model.
• Time course. Show the time course of exposure or cumulative uptake.

4.6.5. Contact menu

The Contact menu entry specifies the contact part of the exposure and uptake model. The
contact parameters define the function ���� as defined in Van Veen (1996). The body weight
or body weight distribution of the exposed persons is also defined here.
• Define to actually define the contact parameters,
• Human to specify the human body weight.

4.6.6. Exposure menu

The Exposure menu entry defines the exposure part of the exposure and uptake model.
Exposure is defined as the concentration of the chemical compound in the medium in contact
with the body. It defines the function ������ as defined in Van Veen (1996). In the present
version of the program, spatial differences in exposure are not allowed. Therefore, the
exposure function reduces to a function depending on time, �����
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The entry contains the routes of exposure as subentries. Choosing one of the routes displays a
dialog box which allows you to set up the route, including the scenario of exposure and the
parameters belonging to that scenario. If no scenario has been chosen and the scenario box
displays "none", no parameters can be set and the "parameter" button does not react. It is
possible to define exposure through multiple routes and the results of multi-route exposure
will be shown in the Report menu entry.

4.6.7. Uptake menu

The Uptake menu entry defines the uptake part of the exposure and uptake model. Uptake is
defined as both the intake rate of the medium and the uptake through the body boundary.  It
defines the function ������������ as defined in Van Veen (1996). The entry has the routes of
uptake as subentries. Choosing one of these routes displays an uptake definition dialog, which
allows you to set up the uptake for that route. From the dialog box, the uptake model, the
scenario of uptake, and the uptake parameters are chosen.
The uptake model can be a fraction model or a diffusion model. The fraction model calculates
the uptake by means of the absorbed fraction. The diffusion model calculates the uptake by
means of a two compartimental diffusional uptake model, described in section 3 of Van Veen
(1996). For inhalation uptake a third model is available, the equilibrium flow model, as used
by e.g. Ramsey and Andersen (1984) or McKone (1993). This model is based on equilibrium
exchange in the lung.

4.6.8. Help menu

Accesses the help system of the program.
• Info. General information on the CONSEXPO 3 program.
• Routes of exposure. Information on the routes of exposure and the available models

for the routes.
• Database. Information on the defaults database and its use.
• Menu. Information on the menu of the program and the meaning of its entries. In fact the

on line version of this chapter.
• Tutorial. The online version of the tutorial.
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CONSEXPO 3 is a multiroute, single chemical modelling tool. Exposure and uptake models
can be defined for each route of contact. The models and their parameters are presented here.
First, contact is discussed. Second, exposure and uptake models are presented per route of
exposure.

,
&
� ��
����

For all routes of exposure, the parameters to describe contact are frequency, duration of actual
use, duration of contact and start of contact. The default values depend on the contact scenario
that is selected. If no contact scenario is selected, i.e. scenario "none" is selected, the system
defaults are displayed. The meaning of these parameters and the system defaults are defined as
follows:
• 4��1��
��.  the frequency of use, in number of events per time interval. The Report-

>Point box gives year averaged values for route specific uptakes. A frequency of 1/year
actually implies that route specific uptakes are the uptake for 1 event.

• '���� -���� �
. the total duration of contact per event. This duration is the full time
interval of contact, whether the product is actually used or not.

• -���� �
 �)����. the duration of actual use of the product per event. This is the time
interval that the chemical compound is released from the product.

�������+��,�������	��	���	����������
�����.
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• �����. the start of contact relative to the onset of the exposure. For users, this parameter
should be set to 0, implying that contact start at the moment the product is used (at t=0).
The parameter is useful for bystanders when the exposure varies in time, for instance when
the concentration is build up slowly.  The start of contact defines which concentration is
initially contacted.  If the exposure is a constant concentration, the start parameter is
unimportant and should be 0.

,
	
� $
(���� �
�/����

Many products and the chemicals therein reach our body via the air and enter the body via the
inhalation route.  A simple example is a spray containing a volatile product. After spraying the
product, chemicals in the product fill the room and the inhaled air will contain these
compounds. The scenario’s defined in the program are developed to describe exposure to
consumer products. They do not adequately describe exposure to outdoor pollutants, for which
day to day and hour to hour variations in the concentration are important in calculating the
mean exposure.
In comparison to CONSEXPO 2, the 3rd version adds two spray models, a simplistic well
mixed model with no evaporation and an extended cloud model with evaporation. The spray
models are based on the theory presented by Reist (1993) and Matoba et al. (1998). They
model generation of spray droplets. The well mixed room model disperses these droplets in
the room, the cloud model describes a spray cloud floating to the floor.

5.3.1. Inhalation contact

The contact with a compound is defined using the define subentry of the contact menu
entry, see section 5.2.

5.3.2. Inhalation exposure

To describe the inhalation exposure, the program defines six exposure scenarios. The constant
concentration scenario, the source and ventilation scenario, the evaporation from pure
substance scenario, the evaporation from mixture scenario, the indoor exhaust gas scenario,
the paint scenario, the spray: well mixed scenario and the spray: cloud scenario. Together,
these scenario’s allow for a wide range of situations.

��
���
����
��
���� �
. In this scenario, the concentration in a single room is assumed to
be constant. It is assumed that the amount of product that is released immediately fills the
room and achieves an average concentration.  This might be valid for volatile products with
high diffusion rates.  See Vermeire et al.  (1993) for background information. The equation to
calculate the exposure is

E
w q

V
f

room

=

where - is the product amount released, w f  is the weight fraction of the compound in the

product and Vroom  the volume of the room.

The parameters of the Constant Concentration scenario can be described as follows:
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.
	����/�������: the amount of product released in the room.

0������������	�: the weight fraction of the chemical in the product.

/		
�1	��
�: volume of the room in which the exposure occurs.

��������
��5�
� ��� �
. This scenario describes a room where some source emits
a chemical compound in the air, while the room is also ventilated with ambient air. The
ambient air might be clean, but it also might contain the chemical compound of interest,
emitted by other sources.  This scenario generates exposures changing with time, making the
contact start parameter (see contact menu entry) an important one. The formula is based on
Sparks et al. (1994):

V
dE t

dt
S Q E t C eV E troom room ambient room

( )
( ( ) ) ( )= − − −

where E t( )  is the exposure in the room, Vroom  is the room volume, (�the generation rate of
the compound, Qroom  the effective ventilation rate, Cambient  the ambient air concentration and �

the break down rate of the compound. This differential equation can be solved with initial
concentration E0  to give:

E t E e
S Q C

Q eV
e

e Q
V t

room ambient

room room

e Q
V troom

room
room

room( ) = + +
+

−
�
��

�
��

− +�	 
� − +�	 
�
0 1

The scenario is based on the following parameters:

2�������	��/���: generation rate of the compound in weight per time released into the air.

1��������	��/���: amount of air that ventilates the room per unit of time.

.
$�����%	���������	�: concentration of the compound in ambient air which is used to ventilate the

room.

3���!�,	 ��/���: the break down rate of the compound in fraction per time unit.

/		
�1	��
�:  volume of the room in which the exposure occurs.

�������� �
�)���������������
��. This scenario defines a situation in which a pure
substance evaporates in a room. The evaporation rate depends on the difference in vapour
pressure between the pure substance and the actual vapour pressure of the evaporated
substance
in air. Additionally, the room is ventilated with ambient air. Eventually, an equilibrium will be
reached between the concentration in the substance and in air. This scenario is derived from
Jayjock (1994). The scenario can only be calculated if the fysico-chemical properties of the
compound are given in the Compound menu entry.
The equation given by Jayjock (1994) is slightly extended to incorporate initial concentrations
which are not equal to 0.

E t E e
K MAP

RT K A Q
e

K A Q

V
t

t

t room
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V
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t room
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+

−
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where E0  the initial compound concentration in air, Kt  a constant calculated from the
molecular weight, . the area from which evaporation takes place, Qroom  the effective
ventilation rate, Vroom  the room volume, # the molecular weight, � the vapour pressure of the

compound, / the universal gas constant, and � the absolute temperature.

Its parameters are:

/�������.���: the surface area of the canned product which is in contact with the air.

��
��������: The temperature in the room.

/		
�1	��
�:  volume of the room in which the exposure occurs.

�������
��1��������	� /���: amount of air that ventilates the room per unit of time.

�������� �
�)����0 �����. This scenario defines a situation where chemicals evaporate
from a product consisting of a mixture of chemicals. The evaporation rate is driven by the
difference of equilibrium vapour pressure and the actual vapour pressure. The model
simplifies the concentration of the chemical in the product to a constant value. The model is
not valid if the concentration changes significantly. In that case, the ‘paint’ model is more
appropriate.
The room is ventilated with clean ambient air, and therefore the concentration of the
compound in air will reach an equilibrium. This scenario is derived from Jayjock (1994),
combined with Raoult's law. The open can scenario assumes that the product is a binary
mixture, consisting of the chemical of interest and an “averaged chemical”, replacing the other
chemicals. The scenario can only be calculated when the properties of the compound are given
in the Compound menu entry. The equation for the evaporation has already been given in the
pure substance scenario. Raoults law is expressed as:

P
x

M

x
M

y
M

part
x

x y

=
+

where Ppart  is the partial vapour pressure of compound x in the product, � is the concentration

of the compound �, Mx  is the molecular weight of compound �, * is the concentration of the
other compounds, and My  is the average molecular weight of those compounds.

Its parameters are:

/�������.���: the surface area of the product which is in contact with the air.

��
��������: The temperature in the room.

/		
�1	��
�:  volume of the room in which the exposure occurs.

�������
��1��������	��/���: amount of air that ventilates the room per unit of time.

#	�������� ������
�����4 the average molecular weight of the matrix which contains the chemical of

interest.  If this matrix is a combination of compounds, use the weighted average of the molecular

weights, where each compound is weighted by its concentration in the matrix.
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$
�������(�����3��. The scenario predicts carbon monoxide concentrations in a room from
combustor and room characteristics. A pictorial scheme of the model is displayed in figure 4.
A single room is modelled, where a natural gas combustor (e.g. a stove, heater, or geyser)
emits exhaust gas containing CO into the room. The CO2 content of the air used for
combustion determines the CO production of the combustor (De Vries and Bartelomeus,
1973).
Experiments (De Vries and Bartelomeus, 1973) have shown that hot exhaust gas separates the
room air in a warm upper and a cold lower layer. Exchange between both layer decreases with
increasing temperature gradient. The model distinguishes three air layers in the room: 1) the
air directly above the combustor; 2) the air in the warm upper layer; 3) the air in the cold
lower layer.
Ventilation is separated into outgoing and incoming components. Outgoing ventilation is
forced by (mechanical) ventilation located above the combustor and/or outer wall. Incoming
ventilation is situated near the bottom, in the cold lower layer. It suppletes the air removed by
outgoing ventilation.
Validation experiments by Dijkhof, Bakker and Meuleman (1999) showed that the model
performs well for ventilation volumes below 0.5 Air Changes per Hour (ACH in hr-1). The
measurements are within 85% of the model prediction, both for the warm upper as for the cold
lower layer. The model overpredicts the CO concentrations for higher ventilation volumes, a
factor 2 for 1 ACH and a factor 4 for 5 ACH. They suggest to include a parameter that
describes the amount of exhaust gas that is directly removed. The idea is that high ventilation
increases the pressure on the warm upper layer and more exhaust gas is removed than
expected from air ventilation alone. That suggestion is followed by introducing a factor �ORVW
representing the fraction of exhaust gas that is immediately lost.

�������5��(���
��	������%&6%&�7
	����
.���������		
������$��
����������������*���� ��������$���������� �������	���8�*���������"
 ��
���*����������������	
������	�����*���+��������������$*�������	 ������
������9�������
��������
��������	����	 ������
�����!�����������	 �	����������������������
������!������!�
�������������	 �
������$�� ����������*����

OUTDATED



page 26 of 64 RIVM report 612810 011

These considerations lead to a three compartment model for both CO and CO2 (see fig. 4),
which is numerically solved by CONSEXPO by a fourth order Runga-Kutta method. Because
the CO and CO2 concentrations differ for the different layers, the direction of air flow matters.
Therefore, the following boolean variables are defined, which are 1 if the condition following
the = is true and 0 otherwise.
I k Q1 1 1= >
I k Q Q2 1 1 2= - >

In fact, the variables � define direction of air flow by calculating the net flow of air.

For CO2, the following mass balance equations apply, where subscripts 1,2, and 3 refer to the
compartment as depicted in figure 4.

� �
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For CO, the equations follow the same mass balance as the CO2 equations.
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The parameters that appear in the model equations are:
(&22 : the production of CO2 (mg/min);
SCO: the production of CO (mg/min);
�ORVW: fraction exhaust gas immediately lost;
k1: airflow through the burner (cm3/min), determined by its kilowattage;
k2 : exchange rate between compartment 1 and 2 (cm3/min);
k3 : exchange rate between compartment 2 and 3 (cm3/min);

Q1: ventilation rate of compartment 1 (cm3/min);
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Q2: ventilation rate of compartment 2 (cm3/min);
Q3 : ventilation rate of compartment 3 (cm3/min);

V1: volume of compartment 1 (cm3);
V2 : volume of compartment 2 (cm3);
V3: volume of compartment 3 (cm3).

CONSEXPO asks for the following parameters to quantify the model. These define all model

parameters as defined in the above.

%&���	�����	���The production of CO depends on the concentration of CO2 in the air. At low CO2

concentration. CO is produced at basic levels. At a certain CO2 concentration, CO production

quickly rises. Two parameters describe the CO production function, the CO production constant

and the CO asymptote. The function is a quadratic hyperbolic function:

2 2
2

([ ])
[ ]
SURGFR
!

( %&
8 %&

�
�

.

Regrettably, this function is burner specific and more research is needed to outline generalisations.

The curve is routineously measured during safety checks of new burners.

CO production constant !SURG. The production rate of CO at a CO2 concentration where
2

2[ ] 18 %&� � .

CO asymptote 8. The CO2 level (measured as squared %) that acts as asymptote for the CO

production rate.

������	���������*��	����The fraction of exhaust gas (that is both CO and CO2) that is directly lost after

emission. Dijkhof, Bakker and Meuleman (1999) give the following table based on experimental

findings:

Air Changes per fraction direct mix upper/
Hour (hr-1) lost lower (m3/hr)
0.5 0.15 25
1 0.30 17
2 0.50 7
3 0.65 3
4 0.70 1
5 0.75 0

These values have been measured for a kitchen of 15 m3, no validation for other room sizes has

been attempted. Dijkhof, Bakker and Meuleman (1999) also remark that the fit of the model

improves when the mixing between upper and lower layer reduces for increasing ventilation

volumes. These data are added in the table.

/		
�
	��
�. Volume of the room where exposure takes place, including all layers of the above

mentioned

/		
��������. Surface of the room. Room volume and room surface together determine the room

height.

&������������. The height of the outlet of the burner, where exhaust gas enters the room air.
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#�������������������*���. A mixing factor which determines how well both upper layers are mixed by

exchange of air.

#�����������6�	 �����*��. A mixing factor which determines how well the upper and lower

compartiment, number 2 and 3 respectivily, mix by exchange of air. The mixing factor as given

here is the base factor at a zero temperature gradient. The model assumes an exponential decrease

of mixing by an increasing temperature gradient, with a half life of 30 minutes, as observed in

experiments (Dijkhof, pers. comm. 1997).

!0�3�����. The kilowattage of the burner.

��������
��������	�. The outward directed ventilation in the air compartiment just above the burner

(compartiment 1).

������
��������	�. The outward directed ventilation in the upper air compartiment next to the burner

(compartiment 2).

�� 
� 
!. The scenario predicts the exposure to chemicals evaporating from paint applied to a
surface in a single room. The model is schematically represented in figure 4 and described in
full by Van Veen et al (1999). The painted surface is subdivided in two layers, the upper one
exchanges the compound with air, the lower one acts as a store. The “Painting” scenario
models a finite amount of compound in the paint, in contrast to the “Evaporation from
Mixture” scenario. In the “Painting” scenario, evaporation stops when the compound has
disappeared from the paint.
The model has been validated by Van Veen et al. (1999; submitted) using organic solvent
paint and monitoring n-alkanes in the range n-octane to n-undecane and using paint stripping
with dichloromethane. In summary, the model predicts upper levels well, including peak
concentrations and half life in the room, but for slowly evaporating chemicals as alkanes, it

�������:��(���
�����������������	��	���������������
	����
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has difficulties to predict the exact timing of the peak concentration.
The “Painting” scenario uses a Runge-Kutta fourth order numerical algorithm to solve the
underlying differential equations. The algorithm is expected to converge for many parameter
settings, but it may fail. The user is urged to check if the calculated time course does not
contain any anomalies, before using summary measures.

The parameters used in the model are the following:

/�����������. The painted area from which chemicals may evaporate.

��	������
	���. Amount of product used to paint.

0������������	�. Weight fraction of the compound of interest in the paint.

,�����*���	����. Density of the paint.

8�*����������������. Exchange rate between the lower, reservoir layer and the upper layer of paint.

������	���	���������*��. Fraction of paint applied to the upper layer during painting.

/		
�
	��
�. Volume of the room.

�������
��
��������	�. Ventilation rate of the room.

��
��������. Room temperature. The paint is assumed to have the same temperature as the room.

#	�������� ������
�����. Typical molecular weight of the "other" chemicals with relative low

molecular weight in the paint.

�����2�*����� ���������
�The model describes indoor exposure to chemicals in spray
droplets assuming that the droplets are well mixed in the room and no evaporation of the
chemical occurs. The latter assumption reduces the air concentration to zero when all droplets
are on the floor. If droplets are not well mixed but form a coherent cloud and if evaporation
matters, select the spray: cloud model. If evaporation is quick, emission is just like the
emission of vapour and the source and ventilation model is appropriate.

The air concentration %URRP  is calculated from (Reist, 1993: eq. 6.23-6.27)

URRP

URRP URRP URRP

�%
1 ( �% 9%

��
� � � .

The source term ( of the droplets is an emission rate (amount per time) of droplets of given
size. The removal rate � of droplets from the air compartment is set by calculating the terminal
settling velocity from Stoke’s law (Reist, 1993). The removal rate of aerosol droplets is
calculated as W� 
 ;� , where 
W is the terminal settling velocity and ; the release height. The

terminal settling velocity is calculated from 
2

0.00329W

� �
 �� cm/s (Reist, 1993: equation 6.5

and 6.10), where � is droplet radius, ρ is formulation density, � is gravity and 0.00329 a
compilation of air viscosity and a constant 18. Removal by ventilation is driven by ventilation
rate 9.
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The parameters in the model are the following:
2�������	��������	�
�����	�. The amount per time of formulation emitted by the product.

0������������	�. The weight fraction of chemical in product.

.��$	����������	�. The fraction of formulation that enters air as aerosol droplets. The complement of

this fraction is supposed to deposit on a surface.

,�����*. Density of the formulation or product

/		
�
	��
�. Volume of the room.

�������
��
��������	�. Ventilation rate of the room.

,�	�������<�. Size of the droplet, assume the droplet is a sphere.

/�������������. Height at which the droplets are released.

�����2������������. The model describes exposure to an aerosol emitted by a spray can. The
model assumes that the spray can produces an coherent cloud of spray droplets and that the
chemical may evaporate from droplets and target area. The coherent cloud of spray droplets
divides the room in two compartiments: a compartiment that just contains the cloud of
droplets and a compartment that contains the rest of the room. Exposure to spray droplets can
only occur in the cloud compartment. Exposure to evaporated chemical can occur in both the
cloud and the remaining room compartiment.
In the model, the user will be exposed to the cloud compartment, while the non-user is
exposed to the remaining room compartment. At the moment, partial exposure to the cloud
compartiment is not implemented. The size of the cloud is calculated from the cloud radius
and the release rate. These two measures are used to calculate a tight box around the cloud.

�������=��(���
���������������	��	������(���*����	���
	����
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The model is a compilation of the spray: well mixed model and the paint model. Droplet
behaviour, i.e. settling, is defined as in the well mixed model, but droplets are confined to the
cloud compartment. The evaporation rate is defined as in the paint model, using the surface of
the droplets and the target area and taking into account that the concentration in the product or
formulation decreases. The model assumes that droplets that hit the target evaporate into the
room compartment, while droplets floating in the cloud evaporate to the cloud compartiment.
The amount of chemical in the cloud compartment is a summation of the amount in the
droplets and the amount that has evaporated but is still in the cloud. The amount of chemical
in the droplets is described by

� � � �, ,
GU S HW

GU S HW DLU GU S HW SU GX W GU S HW SDUW GU S HW D W XG

�%
1 � ( % % > � �

��
� � � � ,

where >, �SDUW�GURSOHW, and �DFW�FORXG are the exchange rate constant and vapour pressures for the
chemical in droplets in the cloud, and are defined in the paint model (see Jayjock, 1994; Van
Veen et al., 1999). The volume of droplets in air 1GURSOHWV is given by

GURSOHWV

DLU GURSOHWV GURSOHWV

�1
� ( �1

��
� �

where (GURSOHWV is the generation rate of droplets, �DLU is the fraction of droplets that becomes
airborne, and � is the removal rate of droplets (as defined above in the well mixed model). The
exact radius of the droplets depends on the solvent. If the solvent does slowly evaporate, the
user given radius is used. If the solvent evaporates quickly, a new radius is calculated
assuming that only the chemical remains. The evaporated amount in cloud air is

� � � �_
, ,

FORXG DLU

FORXG SDUW GURSOHW DFW FORXG FORXG FORXGDLU URRP

�%
1 > � � 9 % %

��
� � � � ,

and the amount in the remaining room volume is

� � � �, , _
URRP

URRP SDUW REMHFW DFW URRP FORXG FORXG DLU URRP URRP URRP

�%
1 > � � 9 % % 9 %

��
� � � � � ,

where the 1FORXG and 1URRP  refer to the cloud and room compartment volume respectively,
9FORXG and 9URRP refer to the ventilation rate of the cloud and the room compartment
respectively, %FORXGBDLU and %URRP refer to cloud and room vapour concentrations of the chemical
respectively, and >���DFW�URRP�and��SDUW�REMHFW refer to room and object specific evaporation
parameters (see paint model). The room volume is the total room volume from the dimensions
of the room minus the cloud volume. The cloud ventilation rate is proportional to the room
ventilation rate as

FORXG

FORXG URRP

URRP

1
9 9

1
� ,

although this may underestimate cloud ventilation (see Riley et al., 2000). Finally, the product
or formulation forms a layer of volume 1REMHFW on the target. The volume of this layer increases
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by 1REMHFW�?���7�DLU�@(GURSOHW@�, where � is time. The amount of chemical in the layer on the object
is described by

� � � �, ,(1 )RSMHFW

REMHFW DLU GURSOHW SURGXFW REMHFW GURSOHW GURSOHW SDUW REMHFW DFW URRP

�%
1 � ( % % �1 % > � �

��
� � � � � �

using parameters defined in the above.

The parameters in the model can be summarised to be the following:

2�������	��������	�
�����	�. The amount per time of formulation emitted by the product.

,�����*. Density of the formulation or product

0������������	�. The weight fraction of chemical in product.

.��$	����������	�. The fraction of formulation that enters air as aerosol droplets. The complement of

this fraction is supposed to deposit immediately on a surface.

,�	�������<�. Size of the droplet, assume the droplet is a sphere.

/�������������. Height at which the droplets are released.

/��������	��. The initial radius of the cloud near the spray can.

������������. The area from which chemicals may evaporate.

/		
�
	��
�. Volume of the room.

�������
��
��������	�. Ventilation rate of the room.

(	�
�����
��	����	�. A switch to set if the solvent evaporates fast (approximated by immediately) or

slow (approximated by not). For slowly evaporating solvents, the radius of the droplets is the user

given radius. Otherwise, for fast evaporating solvents, the droplet is chemical only and the radius

is proportionally decreased.

5.3.3. Inhalation uptake

To calculate the uptake of a compound in the lung, three models are available, the fraction
model, the equilibrium flow model and the diffusion model. Background information
on the models is given in Van Veen, Olling and Vermeire (1994). For particulate material, the
nose and larynx act as filter (Freijer et al., 1997). Material deposited in this region is generally
swallowed and enters the gastro-intestinal tract.

4���� �
�0����. The fraction model calculates the uptake rate as
U t F Q RE tl( ) ( ).=

The primary factor that expresses uptake in the foregoing equation is � the fraction taken up.
It is multiplied with Ql , the inhalation rate, /, the respirable fraction and E t( ) , the exposure.

To calculate the total amount taken up, the integral over the duration of exposure � is taken
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U U t dtc

T

= � ( )

The scenario contains the following parameters:

%	������������	� (defined in the contact menu)

��������	������. The volume of air that passes the lungs in a certain amount of time. The default value

is based on the body weight that is defined in the Contact->Human menu and the degree of

activity. The default is calculated using Freijer et al. (1997) and ICRP (1994).

.$�	�$���������	�. Fraction of chemical that is absorbed in the body.

/������$���������	�. The fraction of the compound that enters the lung and is not deposited in the

throat.  the fraction �7/ is deposited in the throat and enters the oral route of uptake. A respirable

fraction of 1 is valid for gaseous chemicals which are not deposited. For aerosols, the value is too

high and should be adjusted according to the mean droplet size (fig. 7).

���	����. Exposure is defined in the exposure-inhalation menu entry.
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- ))�� �
�0����. The diffusion model is based on the concentration difference between the
lung air and lung blood (Van Veen, 1996). Essentially, the uptake rate is defined as:

U t A P C t K C tlung lung lung ab blood( ) ( ( ) ( )),= −

where � is the uptake rate, Alung  is the area of the lung wall, Plung  is the permeability of the

lung wall, Clung  is the compound concentration in lung air, Kab  is the air/blood partition

coefficient, and Cblood  is the compound concentration in lung blood. The uptake rate ���� is a
function of time because both the lung air concentration Clung  and blood concentration Bblood

vary in time. The underlying model is explained in detail by Van Veen (1996). It is assumed
that there is no body burden of the compound, resulting in clean venous blood with a zero
compound concentration.
The program calculates the amount of compound taken up from a single breath, and sums all
breaths during the period of exposure. During a breath, when the air inside the lung forms a
compartment that is relatively closed from the outside, the concentration in lung air decreases
as a function of uptake, whilst lung blood takes up the compound from the lung air and is
continuously diluted by inflow of clean blood.
The initial concentration in lung air, Clung ( )0 , is calculated from the concentration in the

ambient air and the fraction of lung air that is refreshed per breath. That fraction is
approximately 0.25 (Silbernagel and Despopoulos, 1993). The initial average concentration in
the lung, just after inspiration, is then approximated by:

C
V F V

V V
Clung

e r

e r
ambient( )

( )
0

1= + −
+

where Cambient  is the ambient concentration, � is the fraction of the compound taken up during
a breath, Ve  is the expired amount of air, Vr  is the residual volume in the lung, and
V Ve lung= 0 25. , where the volume of the lung V V Vlung e r= + .

The diffusion uptake model is based on the following parameters:

.��63�		���������	��%	���������. The ratio between the equilibrium concentration of the compound in

air and in blood.

3�		����	 . The flow of blood through the lungs.

3�		��1	��
�. The volume of blood that is present in the lungs.

8����0�������
��$����*. permeability of the wall between the lung air and the lung blood,

predominantly the permeability of the alveolar wall.

Lung Area: Area of the contact surface between lung air and blood.

8����1	��
�: total volume of the lung.

,����(����: fraction of lung air that is not involved with air/blood exchange.

��������	������. The volume of air that passes the lungs in a certain amount of time. The default value

is based on the body weight that is defined in the Contact->Human menu and the degree of

activity. The default is calculated using Freijer et al. (1997) and ICRP (1994).
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/������$���������	�. The fraction of the compound that enters the lung and is not deposited in the

throat.  the fraction �7/ is deposited in the throat and enters the oral route of uptake. A respirable

fraction of 1 is valid for gaseous chemicals which are not deposited. For aerosols, the value is too

high and should be adjusted according to the mean droplet size (fig. 6).

4��*�0����. The flow model is based on equilibrium exchange between a compound in the
lung air and the lung blood.  This involves the air/blood partition coefficient and the blood
flow as transport determining parameters. The permeability of the lung wall Plung  is assumed

to be very large, such that passage of the lung wall is by far not the rate limiting step. It is also
assumed that there is no body burden of the compound, resulting in venous blood with a zero
chemical concentration. This assumption will overestimate the amount taken up. The model is
used and described by e.g. Ramsey and Anderson (1984). It expresses the fraction taken up as:

F
K

K Q Q
ab

ab lung blood

=
+

where the variables are already defined in the “Diffusion model” section. In fact, the
parameters of the model are a subset of the parameters used in the diffusion model. Therefore,
no separate input dialog has been made. Simply neglect the blood volume, lung volume, lung
area, death space and permeability parameters of the diffusion model.

The parameters of the flow model are:

.��63�		���������	��%	���������: The ratio between the equilibrium concentration of the compound in

air and blood.

3�		����	 : The flow of blood through the lungs.

��������	������. The volume of air that passes the lungs in a certain amount of time. The default value

is based on the body weight that is defined in the Contact->Human menu and the degree of

activity. The default is calculated using Freijer et al. (1997) and using ICRP (1994).

/������$���������	�. The fraction of the compound that enters the lung and is not deposited in the

throat.  the fraction �7/ is deposited in the throat and enters the oral route of uptake. A respirable

fraction of 1 is valid for gaseous chemicals which are not deposited. For aerosols, the value is too

high and should be adjusted according to the mean droplet size (fig. 6).

,
+
� -�����������

Dermal contact with consumer products occurs for example when we handle things, when we
spill fluids or when we contact products dissolved in water. Chemicals from the product will
pass the skin and enter blood. Dermal exposure also occurs concurrently with inhalation
exposure because our skin is always exposed to air.  Therefore, setting inhalation exposure
automatically sets a dermal exposure of the same magnitude. Uptake from exposure to volatile
chemicals can only be calculated using the diffusion model of uptake.
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In comparison to CONSEXPO 2, the migration screening model has been updated using
Zeilmaker et al. (1999) and the transfer coefficient and contact rate models are added. The
latter are regularly used for pesticide exposure assessment.

5.4.1. Dermal contact

The contact with a compound is defined using the define subentry of the contact menu
entry, see section 5.2.

5.4.2. Dermal exposure

There are five exposure scenarios defined, and one scenario to model dermal exposure to
airborne compounds. The "Fixed Volume" scenario assumes that the product is well mixed,
and no diffusion gradients occur in the product. The name of the scenario refers to a second
assumption, namely that the volume of product is constant during the time interval of
exposure. The "Diffusion in Product" scenario assumes that the product is not mixed at all,
and transport of a chemical compound takes place by means of diffusion. Then, a
concentration gradient of the chemical will be formed inside the product. The third scenario,
“Migration to skin”, models dermal exposure as a result of migration of product to the skin.
The “transfer coefficient” and “contact rate” scenarios have been added to facilitate biocide
risk assessment. These scenarios are based on data that are typically available for exposure
assessments. They may be useful for other products too.

4 ����5�����. The fixed volume scenario describes uptake from a fixed volume of product
that contacts a certain area of skin.  This fixed volume can be either a small volume that is
spilled on the skin, or a large volume, contacted for example during dish washing. The finite
volume of the product sets the maximal amount of compound that can be taken up to the total
amount present in the product. The scenario assumes that the product is well mixed, and
gradients inside the product do not occur. The exposure is given by:

E
w A

V D
f

product

=

where . is the amount of product, w f  is the weight fraction, , is the dilution and Vproduct  is the

product volume.

The parameters to describe this model are:

��	�����������*. Density of the product.

1	��
��	����	����. the volume of the product that contacts the skin. If the dilution factor is set to

some other value, this volume reflects the volume in which the product was contained before

dilution.
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0������������	�. the weight fraction of the chemical compound in the product. If the product is

diluted before use, the weight fraction in the original product is used and the dilution factor is set.

If you fill in the weight fraction in the diluted product, set the dilution to 1 to indicate that no

further dilution takes place.

,�����	�. the dilution factor. It is equal to 1 when no dilution occurs, values below 1 imply

concentration of the product, and values above 1 dilution. If the weight fraction is determined

before the product is diluted, set the dilution to the number of times that the product is diluted but

if the weight fraction is that in the diluted product, set the dilution factor to 1.

- ))�� �
� 
��������. The “Diffusion in Product” scenario describes dermal exposure to and
uptake from products for which the diffusion gradient in the product can not be neglected.
This will often be the case for solid products and for liquid products with a high viscosity. In
these cases, one has to model the gradient inside the product to be able to calculate the uptake.
The diffusion model is developed in Van Eijkeren (in prep.). The present model also takes the
possibility into account that evaporation of the chemical compound decreases the exposure.
The diffusion gradient inside the product is described by:

∂
∂

∂
∂

E x t

t
D

x
E x t

( , )
( , )=

2

2

where , is the diffusion coefficient of the compound inside the product and E x t( , ) is the

compound concentration in the product at depth x and time t.  At the interface between
product and skin,���?�D. At the product/air border at �?;, the loss of material from the
product is proportional to the concentration difference between the surface of the product and
air

φ air l aK E H t C t= −( , ) ( )� 

where φ air  is the evaporation rate to air, Kl  is the exchange coefficient, ��;����is the

compound concentration in the product at the interface, and %D����is the air concentration.
Momentarily, the air concentration is supposed to be zero.
At the product/skin border, the uptake is governed by the concentration difference between
product and skin blood, the skin itself acting as a resistance between product and blood

φ skin d pb bloodP E t K C t= −( , ) ( )0� �
where φ skin  is the dermal uptake rate, Pd  is the dermal permeability, ��D��� is the
concentration in product at the skin border, Kpb is the product/skin partition coefficient, and

C tblood ( ) is the dermal blood concentration.

The equations are numerically solved using a second order Runge-Kutta algorithm. In order to
use this algorithm, the user has to provide the number of segments into which the product is
divided during the calculations. The default of 5 segments will do in most circumstances. By
modelling the diffusion gradient inside the product explicitly, while modelling the skin simply
as a resistance, one implies that the permeability of the skin for the compound is much larger
than the permeability of the product for the compound. If not, the compound is more slowly
transported by the skin and concentration gradients inside the product are of less importance.
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The parameters in the scenario are:

%	���������	���	
�	���. The concentration of the chemical compound in the product.

,������	����	����. The diffusion rate of the chemical compound in the product.

�
��	����	��������	������. The exchange coefficient between product and air.  It can be calculated by

measuring the evaporation rate in weight per time, and dividing this value by concentration times

exposed area.

����!�������	����. The thickness of the layer of product, measured perpendicular to the skin.

��	��������
����. A parameter specifying into how many segments the product is divided by the

numerical routine.  If this number is very low, the gradient in the product is approximated by a few

segments and the calculations can be inaccurate. Setting a very large number, however, slows

down the calculations considerably. A number in between 10 and 50 will do for most products.

Default: 5. Status of default: allows for quick calculations, which are not too inaccurate.

0 !��� �
������ 
. Calculate dermal exposure by migration of a compound from a product
onto the skin. The model calculates the amount that migrates as:

PLJUDWH FKHPLFDO VNLQ. . 0��

where .PLJUDWH is the amount that migrates (g), .FKHPLFDO is the fraction of chemical that is
leachable (g/g) and �VNLQ is the skin contact factor (Zeilmaker et al., 1999). The skin contact
factor is the fraction of product that is in direct contact with bare skin.

The parameters of the model are:

8�����$��� ������������	�. The amount of chemical in grams that can be leached from one gram of

product.

��	������
	���. The weight of the product.

(!����	����������	�. the fraction of product that is in direct contact with bare skin.

��
���������
��The contact rate describes dermal exposure by describing addition of product
or formulation to the skin. It is a multiplication of the rate of dermal contact with the product
or formulation, the weight fraction of the chemical and the density of the product or
formulation. The contact rate is valid for the application phase and is, per definition, zero for
the post application phase. The amount of chemical that reaches skin is .GHUPDO�?��ZHLJKW�@�/�@��,
where .GHUPDO is the total amount on skin, �ZHLJKW is the weight fraction of chemical, ρ is the
density of product/formulation, / is the contact rate and � is the use duration. The
concentration of chemical on the skin is %GHUPDO�?��ZHLJKW�@�ρ.

The parameters of the model are:

%	����������� The amount of chemical in grams that can be leached from one gram of product.

0������������	�. the weight fraction of the chemical in the product.
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��	�����������*. Density of the product.

'��
�)������)) � �
�
�The transfer coefficient is a coefficient that is derived from data on
dislodgeable amounts on surfaces and dermal loading on skin. The coefficient describes the
area that is completely cleared with respect to the dislodgeable amount of chemical  per unit
of time. In addition to the transfer coefficient, input on the dislodgeable amount of
formulation, the weight fraction of chemical, and the duration of contact are necessary. In
addition, the total contaminated surface restricts the area that contains the dislodgeable
chemical. The half-life of the chemical accounts for the decrease of chemical in time due to
chemical transformations and break-down. The calculation is

( )
HQG

VWDUW

W

GHUPDO GLVORGJH ZHLJKW

W

. �% . � � ��� �� � ,

where .GHUPDO is the total amount on skin, �ZHLJKW��� is the weight fraction of chemical at time �,
.GLVORGJH is the dislodgeable amount of formulation per unit area, �% is the transfer coefficient
in area per unit of time and � is the contact duration. For �ZHLJKW���, simple exponential decrease
is assumed based on the chemical half-life ���� as

1/ 2

0.693147

( ) (0)
W

W

ZHLJKW ZHLJKW� � � �
-

� .

The parameters of the model are:

����������	��������� The area that is wiped free of the dislodgeable amount of product by skin contact

per unit of time.

,���	����$����
	���. The amount of product per surface area that may potentially be dislodged.

0������������	�. the weight fraction of the chemical in the product.

;������������
����� The half life of the chemical in the product as present on a surface. The
parameter accounts for break down of the chemical.

(������� Surface area that is contaminated with the product. This parameter sets a maximum
on the surface that can be wiped free of the dislodgeable product.

5.4.3. Dermal uptake

Three models can be used to describe the uptake of a compound from the product, the fraction
model and the diffusion model. The fraction model is a simple model, when knowledge about
the product is scarce. The diffusion model is a more advanced model, which uses the
concentration difference between the product and the blood in the skin (Van Veen, 1996). The
SKINPERM model is taken from the work of Ten Berge and Wilschut (see Wilschut, 1995;
Wilschut et al, 1995). In the latter two models, the uptake is proportional to this concentration
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difference, with the skin permeability as the proportionality coefficient. In case of exposure to
gases or vapours, the diffusion equation is simplified by assuming that the blood
concentration of the compound is negligible. In the latter case, the uptake rate is proportional
to the concentration of the compound in air.
The skin permeability can be estimated by empirical formula’s which use the >RZ and the
molecular weight to predict permeability.  Six of these empirical formula’s have been
implemented in the program, those from Fiserova-Bergerova et al. (1990), Guy and Potts
(1992), McKone and Howd (1992), Robinson (pers. comm.), Wilschut et al. (1995), and
Bogen (1995). The equations for the dermal permeability �G are derived from the
octanol/water partition coefficient >RZ�and the molecular weight #0 :

1. Fiserova-Bergerova (1990)

P K ed ow
MW= + −1

15
0 038 0 153 0 016. . .� 
   cm / hr

2. Guy and Potts (1992)
P K ed ow

MW= −0 0018 0 71 0 014. . .   cm / hr

3. McKone and Howd (1992)

P MW
h

Kd
ow

= +
+

�
	�
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−
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0 8

1

0 33
0 0000024 0 00003

.
..

. .
  cm / hr

where � is the thickness of the skin, taken as 0.0025 cm.
4. Robinson (Wilschut et al., 1995)

P
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d
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where �VF is the permeability of the, hydrophobic, stratum corneum, �SRO�is the permeability of
the hydrophilic (or polar) pathway through the stratum corneum, �DT is the permeability of the
epidermis, �FDS is the permeability of the capillaries, �FZ is the permeability of the capillary
wall, . is the surface area of capillary wall and � is the capillary blood flow.
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5. Ten Berge, as defined in Wilschut et al. (1995)

P

P P P

P K MW

P
MW

P
MW

d

psc pol aq

psc ow

pol

aq

=

+
+

= − + −

=

=

1
1 1

1326 0 6097 0 1786

0 0001519

2 5

0 5

  cm / hr

log . . log( ) .

.

.

.

6. Bogen (1995)
log . . . logP MW Kd ow= − − +0 812 0 0104 0 616

Wilschut et al. (1995) evaluated most empirical equations, except number 4 and 6, against
measured permeability’s and reported that they predict the dermal permeability within
approximately one order of magnitude.

4���� �
�0����. The fraction model uses the equation
U VEF tc = ( )

to calculate the total amount �F taken up.

The definition of the parameters is:

1: 
	��
��	����	����. Defined in one of the exposure scenarios.

�: ���	����. Defined with the dermal exposure menu entry.

����: �$�	�$���������	�. Fraction of the total amount of compound that is taken up by the body.

- ))�� �
�0����.  The diffusion model is based on the concentration difference between the
product and skin blood (Van Veen,1996). The uptake rate is defined as

U t A P E t K Cd d pb blood( ) ( ( ) )= −

where ���� is the uptake rate, .G is the area of dermal contact, �G the dermal permeability, >SE

is the product/blood partition coefficient, ���� is the compound concentration in the product
and generally a complex function of time and %EORRG is the compound concentration in blood.
The two compartment model behind the uptake rate equation is described in detail in Van
Veen (1996). Essentially, the concentration in the product and the concentration in the blood
compartment underneath the skin form the compartments, and the uptake rate is the amount
transferred from product to blood per unit of time. The concentration in the product decreases
because of uptake, while the blood is continuously diluted by inflow of clean blood.
In case of exposure to airborne compounds, the uptake rate equation is simplified by assuming
that the concentration in the blood compartment is negligible in comparison to the air
concentration. In that case, the uptake rate is given by

U A P E td d= ( ).
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The parameters which are used in this model are the following:

���	����.���. The skin area exposed to the product.

3�		��1	��
��������	����.�����The volume of blood underneath the area of exposure.  Default:

depends on the exposed area.

(!���3�		����	 �������	����.�����the blood flow through the skin at the site of exposure.

�������	��%	������������	����63�		�. the partition coefficient is the ratio between the equilibrium

concentrations in the product and in blood. In case of aerial exposure, product can also be air. If

the product is dissolved in water a value of 1 is recommended because blood is also a solution in

water.

���
��$����*�(!��. a rate parameter which defines how fast the skin is passed.  It can be estimated

from the molecular weight and the octanol/water partition coefficient, both to be set in the

Compound menu entry.  The dermal uptake dialog allows for selecting an estimation equation for

the permeability, or to set your "own value". The empirical equations to estimate the permeability

have been discussed in the above.

�6$���/0������. The SKINPERM model is described in detail in Wilschut (1995) and
most of the underlying theory in Wilschut et al. (1995). SKINPERM is a diffusion model, but
is simplifies the blood concentration to zero. Therefore, parameters relating to body blood are
not relevant and the SKINPERM model only uses the area of contact and the permeability to
calculate uptake. The uptake equations as given in the diffusion model simplifies to

U t A P E td d( ) ( )= ,

where all parameter have been defined in the previous paragraph.
The CONSEXPO 3 program only contains the base version of SKINPERM. For the full
program, refer to the program as ditributed by Ten Berge (contact via ECETOC).

The parameters which are used in this model are the following:

���	����.���. The skin area exposed to the product.

���
��$����*�(!��. A rate parameter which defines how fast the skin is passed. It can be measured or

estimated from the molecular weight and the octanol/water partition coefficient, both to be set in

the Compound menu entry.  The dermal uptake dialog allows for selecting an estimation equation

for the permeability, or to set your "own value". The empirical equations to estimate the

permeability have been discussed in the above.

,
,
� ����������

Oral exposure and uptake from consumer products will occur when products are
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swallowed.  There are two main categories of products that enter the body this way. Firstly,
there is accidental swallowing of products like toothpaste, which are used in or around the
mouth. Secondly, droplets or dust in the air will be partly deposited in the throat during
inhalation. This fraction will be swallowed after a while. The program is neither intended to
estimate exposure to chemicals in food (see e.g. Slob, 1993; Heisterkamp en Olling, 1996, for
an overview of food exposure estimation) nor to estimate the acute, local effects of corrosive
or reactive products.

5.5.1. Oral contact

The contact with a compound is defined using the define subentry of the contact menu
entry, see section 5.2.

5.5.2. Oral exposure

There are four single exposure scenarios to describe oral exposure. The “Single Ingestion”
scenario describes uptake resulting from ingestion of some amount of product. The “Hand-
Mouth” scenario uses a macro-behaviour approach to describe hand-mouth contact. The
“Leaching from product” and “Article migration” scenarios both describe leaching. For the
former, leaching occurs in the mouth, for the latter is occurs to a product or food item that is
eaten afterwards. If the respirable fraction, defined in inhalation uptake, is smaller than 1, a
part of the inhaled particles is swallowed, causing an oral exposure to be present in the
reports.

� 
!��� 
!��� �
. The scenario describes uptake from an amount of product that is swallowed.
The compound is taken up from this limited amount, which sets the maximal amount of
compound that can be taken up to the amount initially present in the product.
The concentration is given by:

E
w q

DV
f

product

=

where - is the amount of product, w f  is the weight fraction, , is the dilution and Vproduct  is the

product volume.

The parameters which describe this scenario are:

��	�����,�����*: the density of product that is swallowed.

.�������1	��
�: the volume of product that is swallowed. In case the dilution is set to 1, this is the

actual volume that is swallowed. In case the dilution is set to some other value, it is the volume of

the product before dilution.

0������������	�. the weight fraction of the chemical compound in the product. If the product is

diluted before use, the weight fraction in the original product is used and the dilution factor is set.

If you fill in the weight fraction in the diluted product, set the dilution to 1 to indicate that no

further dilution takes place.
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,�����	�. the dilution factor. It is equal to 1 when no dilution occurs, values below 1 imply

concentration of the product, and values above 1 dilution. If the weight fraction is determined

before the product is diluted, set the dilution to the number of times that the product is diluted but

if the weight fraction is that in the diluted product, set the dilution factor to 1.

7�
�8����(���
����. The scenario is used to quantify oral exposure originating from dermal
exposure on the hands and subsequent hand-mouth contact. It is automatically selected when a
dermal exposure is present. The scenario asks for the exposure concentration, and calculates
intake from concentration times medium intake rate times use duration.

The parameters of the model are:

%	���������	�. The concentration, mass per volume, in the product on the hands. The program also

allows input of a mass per mass (mass %), but effectivily a densisty of 1 g/cm3 is assumed for the

conversion.

�������	������. The ingestion rate, volume per time, of the product.

9���( 
!�)�����������. Calculate oral exposure by leaching of a compound from a product
into the mouth. The scenario is, for example, applicable to teethers. The model calculates the
concentration in the product as:

E t E e
RA

E V
t

( ) =
−

0
0

�� = initial concentration in product (mg/cm3)
/ = initial leaching rate (mg/cm2/minute)
. = area of contact (cm2)
1 = volume of product (cm3)
��= contact duration (minute)
The ingested amount of the compound upto time ��is calculated from the difference between
the initial concentration and the concentration at time � as:

I V E E t= −( ( ) ( ))0

The parameters in the model are:

%	���������	�. The concentration in the product.

��	�����
	��
�. The volume of the product.

8���������. The leach rate sets the initial leach rate from the product, as measured for example in

laboratory conditions. It is measured in amount leach per time per surface area.

.���. The area in contact with the mouth.
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��� ����� !��� �
�)���������������)���. The scenario has been set up to screen the
migration of a compound from packaging material to food. The model follows the EU
Technical Guidance Document (1996), where the amount available for migration is calculated
by the concentration of the compound in the product times contact surface times the thickness
of the product layer from which migration may occur. The actual migration is determined by a
migrated fraction, calculated from the migration rate times the exposure duration.

The parameters in the scenario are:

.��������	���������	�. The concentration of the compound in the article (packaging material) in

contact with the product.

0��������!����. The amount of article material in contact with the product, measured by the depth of

the article from which the compound may leak into the product.

0��������. Area of the article in contact with the product.

��	�����
	��
�. Volume of product present in the article.

#������	������. Migration rate of the product, given as a rate constant per time. The migration rate

times the exposure duration will define the fraction of compound that has migrated into the

product.

�����������	�����
	��
�. The amount of product actually ingested. May be equal to the product

volume, but is may be less.

5.5.3. Oral uptake

Two models can be chosen to describe the uptake from the lumen of the gut into the blood, the
fraction and the diffusion model. Because of the lack of available parameter value estimates,
active uptake is excluded from the models and only passive diffusion is considered in the
diffusion model. The are two variants of the diffusion model, the mixing tank model and the
complete radial mixing model. The choice between these variants is made in the uptake
definition dialog.

4���� �
�0����.  The fraction model uses the equation ����!��?�1�@���@�� to calculate the
amount taken up.

The definition of the parameters is:

�4�
	��
��	����	����. Defined in one of the exposure scenarios.

�4����	����. Defined with the oral exposure menu entry.

�4��$�	�$���������	�. Fraction of the ingested amount of compound that is taken up by the body.

Please mark the difference between fraction taken up and bioavailability. In the latter case the first

pass effect is included, which is not included in the fraction taken up.

- ))�� �
�0����. The diffusion uptake model of the intestinal tract is based on
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a tube model proposed by Sinko, Leesman and Amidon (1991). In this model, the intestine is
described as a long tube.  Two variants of the model can be used in the program: the complete
radial mixing model and the mixing tank model. The complete radial mixing model assumes
that the product travels through the intestine and releases the compound radially into the wall
of the gut. The mixing tank model assumes that the intestine is one well mixed compartment
from which uptake occurs. Generally, the complete radial mixing model is a better
approximation of the gut and tends to result in a larger fraction taken up.
Both models can be expressed in terms of an absorption number An :

A
LP

Rvn
e=

where 8 is the length of the gut, �H is the overall permeability of the gut wall, / is the radius
of the gut, and 
�is the mean axial fluid velocity in the gut. Using the assumptions for the
mixing tank model, the fraction taken up is expressed as:

F F
A

Amigr
n

n

=
+
2

1 2

where �PLJU is the fraction of the compound that migrates from the product to the lumen of the
gut and becomes available for diffusion. If the assumptions for the complete radial mixing
model are used, the fraction taken up is expressed as:
F F emigr

An= − −( )1 2

Both models share their parameters, which are defined as follows:

���
��$����*. a rate constant intestinal wall permeation.

#������	���	�8�
��. the fraction of the compound that migrates from the product inside the intestine

to the contents of the intestine. This parameter is included to allow for matrix effects.

8�
�����	 : The velocity of the intestinal contents, defining the flow through the lumen of the

intestine.

�����������3�		����	 : The flow rate of blood in the wall of the intestine.

����������8�����: The length of that part of the intestine where uptake takes place.

����������/�����: Radius of the small intestine.
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CONSEXPO contains a database with defaults for models and parameters linked to types of
products. The database is accessible by using the “Select Product Type” and “Select
Chemical” buttons on the model overview. The database contains the following information.
1. Product types and for each product type default models and parameters. The product types

categorise products according to exposure potency. The product types are available via the
“Select Product Type” button, which results in a pick list for product types (fig. 8). First, a
number of main categories are given. Then these main categories are subdivided into
categories of similar exposure. Defaults are defined per category. The supporting data for
the defaults are documented in fact sheets, published as RIVM reports. At the moment a
general fact sheet (Bremmer and Van Veen, 2000a) and a fact sheet paint (Bremmer and
Van Veen, 2000b) are finalised. When new fact sheets become available, the database is
enlarged.

�������E�����	������*����������	������	�����������	�������������������$�� ������������$���
����%&'(�)�&���%���!�	����
���������	�*��	�������������������������������	�*�����	$����
���������
�������F2���,������G�$���	��������	����
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2. Chemical information. The database can be filled with chemical information.

�������������������(������)�����������
�'�� ��������
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CONSEXPO may use two sources for the database:
1. Local version. A local database is shipped with the product.
2. Network version. A network database such as Oracle or Ingres can be used as data source.

The admittance to the network database is arranged via the Borland Database Engine and
the Microsoft ODBC. Settings depend strongly on local server and network definitions. A
CONSEXPO datamodel for database implementation is available from the author.

The selection for a particular data source is made via the Options->System menu choice.
Checking the “Database is local” enables the local version. Additionally, fill in the path to the
database files in the “DB directory” field. Unchecking “Database is local” assumes that the
network is used. The DB directory field is not used in this case.

�
&
� - ���������������

The database may be unavailable when:
• the Borland database engine is not (properly) installed
• the database files are not present in the database path;
• the database is incomplete;
• the database engine can not be initialised.
In this case, the database entries in CONSEXPO are grey and disabled.
If errors occur during database queries, the program will inform you with a message. Most
messages speak for themselves. If an unspecified error occurs, most likely the database can
not be reached (path ? files present ? password OK?).
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Parameters are seldomly undisputed point values, but they tend to be disputed and they tend to
follow a distribution of values. How to cope with these uncertainties and variabilities ? First,
what is the difference between uncertainty and variability ? Variability is the notion that a
parameter might follow a distribution of values instead of being a single value. A good
example is body weight, which varies among persons, although the weight of a particular
person can be accurately measured. Uncertainty describes how sure we are about a certain
value or distribution. Long series of measurements have led to a good understanding of the
distribution of body weight, reducing uncertainty about the shape of the body weight
distribution.  Uncertainty is quantified by specifying a distribution around the most likely
value or by specifying a distribution for the mean and standard deviation of the parameter
distribution.
The CONSEXPO program allows each contact, exposure, and uptake parameter to assume a
single stochastic distribution, to express both variability and uncertainty of parameters.
Therefore, it convolutes variability and uncertainty into one distribution.  There are three
predefined distributions available in the CONSEXPO program, the normal, lognormal and
uniform distribution. In addition, measured data can be used to establish an empirical
distribution. The type of distribution that is chosen to represent a particular parameter
distribution severely affects the eventual distributions of exposure and uptake. The parameter
distributions should as much as possible be based on measured data. If you guess the
distribution of a parameter, then the distribution of the exposure or uptake will reflect this
guess! Fortunately, more and more sources for parameter distributions become available, for
example the exposure factors handbook of the AIHC (1994) and an increasing number of
papers in Risk Analysis.

"
&
� =������������������ �
�

A well known approach in worst case exposure assessment is to take worst case estimates of
the model parameters and to perform the calculations with these worst case parameter values
(Fig. 9, worst case route). In CONSEXPO 3 this route can be chosen by selecting the worst
case option in the exposure definition dialogs (these appear after selecting Exposure-
>Inhalation, Exposure->Dermal or Exposure->Oral). The exposure and uptake
estimates taken from these calculations are referred to as worst case estimates.
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This approach has been nicknamed "cumulative worst case", because of a problem associated
with the approach. Say there are two independent parameters, both having a probability
distribution. If each of these parameters is set at its 95 percentile value, then the probability of
exceeding that value is, per parameter,�D�D:.  However, the probability to simultaneously
exceed the 95 percentile values of both parameters is D�D:��?�D�DD":��D�":H� assuming the
parameters are uncorrelated. For � independent parameters, this probability is D�D:Q, a very
small number if n is large.  Thus, the combination of all parameters being at their 95
percentile values will seldom be met in the real world!
A typical result is that “safe values” derived from such a cumulative worst case estimate of
exposure may be well below the background concentrations of the chemical. In order to deal
with this problem, exposure assessors tend to use “reasonable worst case” estimates for the
parameters: estimates that are conservative, but not too conservative. If a reasonable worst
case estimate would be the 75 percentile, then the probability of two uncorrelated parameters
simultaneously exceeding their 75 percentiles is D�":��?�D�D=":��=�":�H� Still, D�":Q is a small
number if ��is large.
A second approach to calculate worst case exposures and uptakes circumvents this problem
(Fig. 9, probabilistic route). Firstly, uncertain and variable parameters are given an appropriate
stochastic distribution. Then, these distributions are used to calculate the distributions of
exposure and uptake. Once the exposure and uptake distributions are established, 95
percentile values from these distributions are taken.  In contrast with the cumulative worst
case situation, the probability of exceeding that exposure and uptake value is known, being
:H�

exposure estimation

set exposure
factors to worst
case values

calculate point exposure and
uptake estimate

set exposure
factors to
distributions

select (95/99/..) percentile
fromfrom exposure and uptake
distribution

���������	���
�	 ������
�
��
����
�	

�������C��/	������	���
���
��������� 	�������������	����������	�����
	�������
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The benefit of being able to specify the probability of exceedance is gained at the cost of
finding parameters distributions and calculating the distribution of exposure and uptake from
the parameter distributions. In CONSEXPO, two approaches are used, the discrete probability
approach and the Monte Carlo approach. The discrete probability approach assumes that
exposure (and identically uptake) is given by a function ���� that depends monotonically on a
parameter �. The exposure and uptake distributions are then calculated directly from the
parameter distribution, without numerical calculations (see Van Veen (1995) for details).
Calculations are relatively simple for a single parameter distribution. When multiple
parameters attain a distribution, calculations quickly become tedious. The CONSEXPO
program therefore applies this technique only when a single parameter attains a distribution.
The second approach to propagate the distribution of the parameter through the exposure and
uptake models is to use Monte Carlo simulation. First, all parameters that attain a distribution
achieve a value randomly taken from their distribution. Then, exposure and uptake are
calculated, using those parameter values.  This process is repeated, typically in the order of
5000-10000 times. During the Monte Carlo simulation, as many exposure and uptake values
as there are repetitions are gathered. The frequency histogram of these exposure and uptake
values approximates the shape of the probability density functions of exposure and uptake.
The more repetitions, the more accurate the approximation.
Using Monte Carlo simulation implies that a good random generator is needed. The one
implemented in the program is the ran1 random generator from Press et al. (1991). The

procedure to transform the uniformly distributed values from this random generator into
normally distributed values is also taken from Press et al. (1991). The program does not use
latin hypercube sampling, a variation of the Monte Carlo technique. Latin hypercube allows
for a much more efficient sampling of the parameter distributions, gaining insight into the
exposure and uptake distributions in less iterations than the Monte Carlo approach. However,
the same accuracy can be reached with Monte Carlo sampling, although the number of
iterations has to be large.

"
	
� - ��� ��� �
�

The program allows parameters to attain three standard distributions, the normal, lognormal
and uniform distribution.  The dialog to set the stochastic distributions is reached by selecting
the parameter name in any of the parameter definition dialogs.

7.3.1. Normal distribution

The parameters in this program are all restricted to positive values. If their mean value and
their standard deviation are given, and the standard deviation is much smaller than the mean
(say, a coefficient of variation not larger than 20%), the normal distribution might be a good
choice as parameter distribution. The normal distribution specifies a symmetric distribution
around the mean.
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7.3.2. Lognormal distribution

If a parameter is restricted to positive values, as e.g. concentrations are, and the standard
deviation is of the same order of magnitude as the mean, the lognormal distribution might be a
good choice. The lognormal distribution is described by the median and the coefficient of
variation (C.V.). The median is the 50 percentile, the value that is exactly in the middle of the
distribution. The coefficient of variation is the mean divided by the standard deviation.

7.3.3. Uniform distribution

If the only thing that is known about a parameter is a plausible lower and upper bound, the
uniform distribution is a good choice. It assumes that every value in between the lower and
upper bound has an equal probability of occurrence.

7.3.4. Empirical distribution

The empirical distribution is based on data. The program constructs a cumulative distribution
from the data and samples from this distribution. The sampling will therefore only return one
of the data points. Data are contained in a data file. The data file contains measured
concentrations, the dimension of the concentrations and optionally comments. Each line of the
file may contain either of the following:
• A dimension specifier, in the form of:
 dim:xx

 where xx is a valid dimension, i.e. one of the dimensions in the dimension box in the
parameter dialog. Please adhere literally to these dimensions. A dimension specifier is
obligatory.

• A concentration, which has to be a number starting on the beginning of the line.
• A multiple of concentrations, to specify a concentration that occurs more then once. Its

specification is:
 yy*zz

 where yy is the number of occurences and zz the concentration, e.g. 5*10.3.
• Each line not starting with a number and not containing ’dim:’ is considered to be a

comment. If the very first line contains a comment, this comment is displayed in a message
box while reading the file. This comment can be used for a general identifier of the file.

Example:
Example data

dim:mg/kg

3

5.7

4*2.1

10.6

more comments

20.4
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Using the Distribution entry of the Report menu, exposure or uptake distributions can be
drawn on the screen. The distributions are calculated and drawn for each route of exposure
and uptake separately. If all parameters are point estimates, if there are parameters with out of
range values or if there are parameters with missing values, no graph will be shown. If, during
the generation of the distribution, only one parameter appeared to have variation, a point
graph is composed, using the discrete probability function approach. If there are multiple
parameters with variation, the Monte Carlo approach is used. A histogram displays the results
of Monte Carlo calculations. The number of bars in the histogram, the number of points in the
graph and the number of Monte Carlo loops can be changed in the System dialog in the
Options menu.

"
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The uniform parameter distribution and the procedures to display exposure and uptake
distributions allow local sensitivity analysis. Sensitivity analysis tries to relate changes in
parameter values to changes in the result. If a large change of a parameter value results in but
a minor change of the outcome, the model is said to be insensitive to that parameter. If, on the
other hand, a small change in a parameter value causes a large change in the outcome, the
model is said to be sensitive to that parameter.
The uniform distribution is useful to analyse how sensitive exposure and uptake estimates are
to small variations in the value of a single parameter. Instead of a point value, one of the
parameters in the model is given a uniform distribution, to specify a small, symmetric interval
around the point value. Then, the resulting distributions of exposure and uptake are calculated.
From these distributions, the lower and the upper bounds are determined. Using the upper and
lower bounds of the parameter too, the following measure ( can be calculated

S
f u f l

u l
= −

−
( ) ( )

where ���� and����� are the exposure or uptake function ����, using the upper bound
� and lower bound � of the parameter. As one can verify, it is an approximation to �����6��, the
derivative of the model with respect to the parameter.  This measure can be calculated for
each of the parameters, setting a uniform distribution for each parameter in turn. To achieve a
relative measure instead of an absolute one, ( can be divided by the value of the result ���� at
the point estimate of the parameter �

S
S

f pr =
( )

100%

The relative measure�(U facilitates comparison between models where the results differ in one
order of magnitude or more.
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These measures of sensitivity are only local measures.  Firstly, all parameters achieve their
best estimate and then each parameter achieves its sensitivity measure, the others being at
their best estimate. In another assessment problem, where the best estimates of parameters
differ, the parameter sensitivity measures may differ from the earlier estimates. A global
sensitivity analysis, on the other hand, would determine the sensitivity of a model for
parameters regardless of the value of others. This is not possible with the present program.
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The use of CONSEXPO 3 will be demonstrated with the following exposure situation:
Assume someone is cleaning his bicycle with a product that contains 50% tetrachloroethane as
a solvent. The person cleans the bike inside a room which is ventilated. The can with the
solvent is left open in the room. Question: What is the exposure to tetrachloroethane from the
can and how much of it is taken up in the person cleaning the bike ?

%
#
� �����#

Now you are ready to use the program.

%
&
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Select the “Select Chemical” button on the model overview. In the dialog that appears, you
have to define the chemical compound of interest.
The characteristics of tetrachloroethane are:
• Molecular weight: 167.85 g/mol;
• Log Octanol/water partition coefficient: 2.39 (10log);
• Vapour pressure: 5.95 mm Hg.
If the dimension of the dimension box is not the dimension you need, click on the arrow in the
dimension box, and choose the appropriate dimension. Leave the water solubility blank. Now,
Choose "Ok" to accept the compound parameters.

The Retrieve button is only available when you are connected to the CONSEXPO database.

Now, the compound is defined.

%
	
� �����	

No exposure without contact.  Next, the contact entry will be filled in. From the menu bar,
choose the Contact entry. Two subentries are displayed, Define and Human. Choose the
Define entry. The Define Contact dialog is now displayed.
There are two possibilities to define the contact parameters, either from the list of contact
scenarios or by entering user defined values. To select a predefined contact scenario, click on
the arrow in the scenario box. If available, a number of alphabetically ordered scenarios is
shown in the box. A limited number is shown, but other entries can be reached via the scroll
bar on the right.  Our person cleans a bike. If the list of predefined scenarios is present, find
the scenario "Cleaning Bicycle" and click on it.  Now it is displayed in the scenario box.
Inspect the parameters by choosing the parameters button. All contact parameters are defined.
Now, choose Ok to accept the parameters.
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In other cases and when the predefined scenarios are missing user defined values may be
entered. Select “User defined” from the contact scenario list and then select the “Parameters”
button. Now fill in appropriate contact parameter values. Select Ok to accept the values.
Select Ok to accept and close the contact definition dialog.

That is it for contact, neglect the average/worst case choice and continue.

%
+
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No Uptake without exposure. Next, the exposure scenario and its parameters have to be
defined. Choose the Exposure entry from the menu. A submenu will pop up containing the
routes of exposure. In the situation sketched in the above, the route of exposure will be the
inhalation one. Choose Inhalation from the routes. A dialog is displayed which contains three
points of interest: options, scenarios and the parameters button. In this exposure assessment,
the primary interest is in the worst case option. Click on Worst Case to check that option.
Next, choose the parameters button. Eeeh ?? Nothing happens !! That is because a scenario
has to be chosen first. Click on the arrow in the scenario box, and pick the “evaporation from
mixture” scenario from the possibilities. This scenario describes a situation in which a
compound evaporates from a product and it is the closest to the exposure situation given in the
above.
Once again, choose the parameters button.  Now, a dialog will appear in which the values of
the parameters can be given. Set the room volume to 25 m3. Set the ventilation rate to a value
of 2.5 m3/hr. Remember, if these dimensions are not the ones displayed, click on the
dimension box and choose the right one (use the scroll bar !). Set the weight fraction of the
compound in the product to 50% and the molecular weight of the matrix to 500 g/mol.
Suppose, we are uncertain about the actual area, we only know that it is in between 0.5 and
1.5 dm2. First, set the right dimension, dm2, in the dimension box. Then, click on the
parameter name. A dialog appears which allows us to set a distribution for the parameter
instead of a point value. First choose "uniform distribution" (watch the check !), then give an
upper bound of 1.5 and a lower bound of 0.5. That's all we know. Choose Ok to return to the
parameter dialog. Choose Ok to accept the parameters and once again Ok to accept the
exposure definition.

�����
�<<	. People are curious (so are exposure assessors). What is the exposure ? To view this, go to

the Report menu and choose Point from the submenu. A dialog displays where, apart from all the

"unknown" entries, two entries display information, both with the same value (although they have a

different dimension). This is the mean exposure from the scenario that you have set in the exposure

definition (step 4), using the contact duration from the contact definition (step 3). The "WC" right of

the inhalation exposure denotes that you have selected a worst case in the exposure options.
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Last but not least: uptake. The uptake model and parameters can be reached via the Uptake
menu entry (surprise!).  As in exposure, the submenu contains the routes of exposure.  We are
assessing the inhalation route, so the Inhalation entry is chosen from the submenu.  Now the
uptake definition dialog is displayed.  This dialog lets you choose the uptake model in the
options part and lets you set the parameters of the uptake model with the parameter button.
Because the blood/air partition coefficient of tetrachloroethane is known (being 18), we’ll
choose the flow model first and then press the parameter button. Now, all uptake parameters
are shown, but we’ll only need a few. Set the air/blood partition coefficient to 0.05291
(=1/18), the lung blood flow to 5000 cm3/minute and set the activity to light exercise and
accept the default for ventilation rate and set the respirable fraction to 1. We don’t need the
other parameters. Choose Ok. And once again Ok to leave the uptake definition.

That’s it for uptake.

%
�
� ������

What about the results ?
If we choose from the Report menu the Point entry once again, the report dialog is show.
Now, the inhalation uptake is also defined (with a "P" on the right to denote the flow model,
which is mainly based on the Partition coefficient). Also multiroute uptake estimates are
shown, which are sum values over all routes of uptake. One is set in terms of mg/kg body
weight/day and the other in mg/year.
But graphs are more beautiful. To view exposure as a function of time, leave the report dialog
("Ok") and choose "Options" and "Graph display". Alternatively, click on the second button
from the right in the button bar, the white button with the graph. Now, select "Time course"
from the "Report" menu. From the dialog, select inhalation exposure and press "Ok". The
exposure is drawn on screen. If you would have selected inhalation uptake, uptake would have
been drawn. Other entries do not result in a graph, because they are "unknown" in the report
dialog.
What about the effect of variation in the release area in the open can scenario ? In step 4, an
uniform distribution was chosen. To investigate how this variance propagates through the
model, select the "Distribution" entry from the "Report" submenu. Now, choose inhalation
from the exposure part (at the top). Then press "Ok". Now, a graph is shown which shows the
distribution of the exposure model results. The exposure varies around a value of  0.0002
mg/cm3 or 200 mg/m3.
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CONSEXPO 2 contained a number of default values that were programmed into the
application. CONSEXPO 3 omits these values because it relies on the external database for
data. A number of defaults present in CONSEXPO 2 are not (yet) available through the
database because they are not contained in a factsheet. These will be listed here for
compatibility with the CONSEXPO 2. The status of these defaults is that they are based on
expert judgement. In terms of the Q-values in the factsheets (see Bremmer and Van Veen,
2000a), they would attain a Q of 4 or less.

$
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��)��*�������
3�		����	 . The flow of blood through the lungs.  Default value: 6000 cm3/min.  Status of

default: it is the cardiac output of an adult.

3�		��1	��
�. The volume of blood that is present in the lungs.  Default value: 750 cm3.
Status of default: guess.

Lung Area: Area of the contact surface between lung air and blood. Default value: 600000
cm2 = 60 m2. Status of default: literature value for adult.

8����1	��
�: total volume of the lung.  Default: 2500 cm3 = 2.5 liter.  Status of default:
approximated from Silbernagl and Despopoulos (1993).

,����(����: fraction of lung air that is not involved with air/blood exchange. Default value:
0.2. Status of default: guess.

-������������>�� ))�� �
�������
���	����.���. The skin area exposed to the product.  Default value: 4340 cm2, unless the

exposure parameter "product volume" has been defined. Status of default: 4340 cm3 is the
area of hands, underarm, face and neck, together forming the area that is not covered by
clothes in summer. For activities like dish washing, the surface of the hands is more
appropriate. Skin surface areas are tabulated by Vermeire et al. (1993). For focal contacts, a
much smaller area will be necessary and the default will be based on the product amount. If
the product volume is defined, the exposed area is estimated as product volume divided by
10, assuming a layer of 1 mm on the skin.

3�		��1	��
��������	����.�����The volume of blood underneath the area of exposure.
Default: depends on the exposed area.  Status of default:  A layer of 1 mm blood inside the
skin is assumed and the blood volume is estimated from the exposed area by area*0.1.

(!���3�		����	 ������	����.�����the blood flow through the skin at the site of exposure.
Default value: depends on the exposed area. Status of default: The default is estimated by
assuming that the blood flow at the site of exposure is proportional to the area of exposure.
The flow is estimated by 2500 * area / 19400, where 19400 cm2 is the total body surface
and 2500 cm3/min is the total adult blood flow through the skin.
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��. the fraction of the compound that migrates from the product inside the

intestine to the contents of the intestine. This parameter is included to allow for matrix
effects. Default value: 1.0. Status of default: the default value implies that the compound is
fully available inside the intestine. It is a worst case assumption.

8�
�����	 : The velocity of the intestinal contents, defining the fllow through the lumen of
the intestine. Default value: 1.67 cm/min. Status of default: the default value is based on
the assumption that an intestine with a length of 4 m is traveled in 4 hours.

�����������3�		����	 :The flow rate of blood in the wall of the intestine.  Default:  1500
cm3/min. Status of default: a value frequently encountered in pharmacokinetic literature.

����������8�����:The length of that part of the intestine where uptake takes place.  Default
value: 400 cm. Status of default: approximates the length of the small intestine in an adult,
the small intestine being that part where uptake usually takes place.

����������/�����:Radius of the small intestine. Default value: 2 cm. Status of default: guess.
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